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Chapter 20:  Searching for Records and Patients 
There are three search tools in SEER*DMS:   Quick Search, Patient Lookup, and Data Search.  Use 
the Quick Search or Patient Lookup when you are looking for a specific patient’s data.  Use the 
Data Search to review a set of Patient Sets or records; or to create an extract file containing 
Patient Set or record data fields. 

• Quick Search – If your search is based on a single data field, enter the field’s value into 
the Lookup box on the user bar.  You may search for a patient’s data by entering a Patient 
Set ID, Record ID, Import ID, patient name, date of birth, or SSN.   The Quick Search also 
provides a shortcut for opening an AFL, follow-back need or group, contact, facility, or 
worklist task.  It is a shortcut to the Data Search for searches based on Import ID or a list 
of Patient Set or Record IDs. 

• Patient Lookup – Use the Patient Lookup to search for a patient’s data based on multiple 
search fields or to search on fields not supported by the Quick Search.  You may enter 
search values for standard patient identifiers such as name, SSN, date of birth, sex, 
accession number, and medical record number.   

• Data Search – The Data Search allows you to define robust search criteria based on any 
record or Patient Set field, Import ID, Special Study ID, or type of worklist task.  You may 
search for a set of records or Patient Sets by entering a list of Patient Set/Record IDs.  Use 
the Data Search to assign Patient Sets or records to Quality Control tasks, to review unusual 
data, or to create small ad hoc extract files. 

Once you find the data of interest, you may view or edit the data in the record or Patient Set 
editor.  However, you must take precautions to ensure that you do not modify data that are being 
processed by others.  To avoid the loss of effort, you should verify that the data are not involved in 
worklist tasks and are not being edited by another staff member (please refer to the Direct Editing 
of Records and Patient Sets section of this chapter for more information).   

In this chapter, you'll learn about 

• Quick Search 
• Patient Lookup 
• Data Search 
• Reviewing Results in the Data Search 
• Data Search Action Menu 
• SQL Data Searches 
• Direct Editing of Records and Patient Sets 

Quick Search 
The Lookup search box on the SEER*DMS user bar allows you to do quick searches.  It will only be 
available if you have system permissions to view and/or edit patient data.   

 

 

Enter the search text into the Lookup box and press Enter.  If you enter a string consisting of all 
digits, the search will assume that you are searching by Record or Patient Set ID.  The search fields 
supported by the Quick Search are listed below. 
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• Patient Set or Record ID – To open a Patient Set or record in the editor, simply enter the 
ID into the Lookup box.  The ID prefix is optional (PAT-12345678 or 12345678 will work).  
The Patient Set or record matching the ID will open automatically.  To search for a set of 
Patient Sets or records, enter a list of IDs separated by blanks or commas.  The Data 
Search will be opened and the ID filter will be set.  The Data Search does not allow you to 
search for Patient Sets and records at the same time, therefore, the first ID will determine 
whether it is a record or Patient Set search. 

• Patient Name – You may enter “last name” or “last name, first name” into the Lookup box.  
The Patient Lookup will open and display the results of your search. 

• Date of Birth – MM-DD-YYYY format is required (with dashes).  A valid month and year are 
required by the Quick Search.  You may enter 99 for unknown day.   The Patient Lookup will 
be opened with the results of your search.   Patient Lookup results are limited to 100 
matches. 

• Social Security Number – A complete SSN in the NNN-NN-NNNN format is required.  The 
Patient Lookup will be opened with the results of your search. 

• Import ID – Enter an Import ID into the Lookup box to search for records in that import.  
The IMP prefix is required.  The Data Search will automatically open.  The fields displayed 
by default are determined by registry configuration settings.   Data Search permissions are 
required for searches by Import ID.        

• Worklist Task ID – Enter a single Worklist Task ID with the TSK prefix.  The worklist will 
automatically open and the worklist filters will be set to show the specified task.  

• AFL, Contact, Facility, or Follow-back Need ID – If you have the appropriate 
permissions, you may open an AFL, Contact, Facility, or Follow-back Need by entering the 
appropriate ID.   The AFL, PER, FAC, or FBN prefix is required.   This allows you to bypass 
the manager when you wish to view a specific AFL, Contact, Facility or Follow-back Need.  

• AFL or Follow-back Group ID – Enter a single Follow-back or AFL Group ID (the FBG or 
AFL prefix is required).  The AFL or Follow-back Manager will automatically open and the 
filters will be set to show the items in that group.       

Click the information icon next to the Lookup box for a reminder of the search fields that are 
supported. 
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Patient Lookup 
The Patient Lookup can be accessed from the View menu or you can click the Lookup link in the 
user toolbar.  The Patient Lookup enables you to search for a patient’s data based on personal 
identifiers (Name, DOB, SSN, Sex, Race, Accession Number, Medical Record Number).   The Data 
Type, Facility, and Exclude criteria can be used to limit the search to a subset of data. 

 
 

Search Fields in the Patient Lookup 

SEER*DMS uses registry-specific matching algorithms to compare the patient information specified 
in the search fields to Patient Sets and unlinked records in the database.  The Patient Lookup 
matching algorithm is documented on the Matching help page in SEER*DMS.    

A score is calculated for each possible match.  The score allows SEER*DMS to sort the results by 
the likelihood of the match.  Entering multiple identifiers quickens the search and increases the 
score of true matches.  It is recommended that you enter information into as many fields as 
possible or enter a unique identifier, such as Social Security Number.  If searching for a patient 
with a common name, it is particularly important to enter values into as many search fields as are 
known.   At a minimum, you must enter one of these fields; SSN, Last Name, DOB, Accession 
Number, or Medical Record Number. 

The search fields are listed below.   

• Name (L,F,M) – Three search fields are provided for searching by patient name.  You may 
enter a full or partial name in any or all of the boxes.  The boxes are displayed in the order 
of last name, first name, middle name.  However, you may enter “Last, First” into the first 
box.  SEER*DMS will automatically parse the text into the two fields for the search.   

• DOB – Enter date of birth in MMDDYYYY or MM-DD-YYYY format.  If you only know the 
patient’s year of birth, enter 99 for day and month (e.g., 99-99-1961).  A valid month and 
year are required when other patient identifiers are not specified (last name or social 
security number). 

• SSN – Only complete Social Security Numbers may be entered.  The value may be 
formatted as NNNNNNNNN or NNN-NN-NNNN. 

• Sex – A lookup enables you to search for data based on a valid code for sex.   
• Race – A lookup enables you to search for data based on a valid code for race.  One value 

for race may be selected.  
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• Accession – Only complete Accession Numbers may be entered.  Accession Number is the 
facility’s identifier for a CTC.  A search by Facility ID and Accession Number should return a 
single result.   However, if you do not know the Facility ID or believe the facility may be 
coded incorrectly then you should search only by Accession Number. 

• Med Rec # – Only complete Medical Record Numbers may be entered.  Medical Record 
Number is the facility’s identifier for a patient.   Two or more patients may have the same 
Medical Record Number if those MRNs were assigned by different facilities.   You have the 
option of searching by Facility ID and MRN (one result should be returned); or you may 
search by MRN without the facility, but multiple results may be returned.   

You must specify a value for at least one of these fields:  last name, Social Security Number, Date 
of Birth, Accession Number, or Medical Record Number.  The Patient Lookup is designed to search 
for data for a specific patient; you cannot use it to generate a generic list of data by sex, race, 
record type, or facility.  To create such a list, you should either use the Data Search, as described 
later in this chapter, or query the database using an external tool.  

Limiting the Search 

You may specify the records and Patient Sets to be searched by entering values for facility, data 
type, and the “exclude” field.  Unlike the Search Fields, these criteria are never weighted.  They are 
used to make a definite determination of whether a record or Patient Set is “in” or “out” of the 
search results.  

• Facility – Limit the search to Patient Sets with admissions or treatments related to a 
specific facility (this may be the reporting or treating facility), or to unlinked records that 
were provided by the facility.  Leave this field blank to search all data regardless of facility. 

• Exclude – Exclude Patient Sets and records for patients who have been dead for more than 
the specified number of years (based on vital status and date of last contact).   Leave this 
field blank to search all data regardless of vital status.  The default setting for this field is 
determined by a User Preference setting.  To change the default, click the Account link in 
the user toolbar (next to the Lookup search box). 

• Data Type – Search all Patient Sets and unlinked records, or limit the search to one or 
more data types.  To include linked records in the search, you must include Patient Sets.  
The Patient Set to which the record is linked will be returned.  Selecting a specific data type 
will return unlinked records. 

Executing the Search in the Patient Lookup 

Enter as much information as known into the form and click Search.  As many as 100 matches will 
be displayed.  The results will be sorted by score with the best matches listed first.  The results will 
include records and/or Patient Sets which, according to your registry’s matching algorithms, 
yielded a score greater than zero when matched using the search and exclusion criteria.  To view 
the algorithm, click the View Matching Algorithm link shown below the search criteria. 

You may click an ID to open a record or Patient Set in an editor.  If the data are involved in a 
worklist task, a link will be displayed in the Tasks column.  The link indicates the user who is 
assigned to the task or that the task is unassigned.   Other data columns are described below. 

To search for a new patient, click the Reset button.  Patient information that you entered will be 
removed, the Facility field will be cleared, and the Exclude field will be set to the system default.    

Patient Lookup Search Results 

The columns listed below are shown in the search matches.  The value in the table will be shown in 
bold if it is an exact match to a search field.  If the matching algorithm supports partial matches for 
Social Security Number and Date of Birth, only the matching fragment will be shown in bold.  Fields 
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not listed may have been involved in the search.  For example, the matching algorithm may 
compare last name to maiden name or alias last name.   

• Score – A value calculated by the matching algorithm that allows the results to be sorted 
by the likelihood of the match.  You may click the score to view a summary of the 
calculation.  Results with the highest score are displayed first.   

• Task – If the data are in a worklist task, a link will be displayed in the Tasks column.  The 
link will be “unassigned” or the username of the person to whom it is assigned.  

• Facility – If the data type is a record, then the reporting facility will be displayed. 
• Type – Data type.  Patient Set or a record type will be listed.  If the match is a record and 

the record’s reportability status is something other than “reportable”, an icon will be 
displayed: 

  Non-reportable 
  Auditable 
 Unknown (reportability flag not set; screening has not been completed) 

 Not applicable; the record type is not screened (e.g., supplemental records) 
---  No icon is displayed if the record is reportable. 

• ID – Patient Set or Record ID.  Click the Information Icon  next to the Record’s or Patient 
Set’s ID to see a select set of fields.  To browse all pages of the record or Patient Set, click 
the Record’s or Patient Set’s ID. 

• Last Name, First Name, Middle – Patient’s last, first, and middle name.  If the text is an 
exact match to search criteria, it will be shown in bold.  If the name is too long to display, 
an ellipsis will be shown at the end of the name (…).  

• DOB – Date of birth. 
• SSN – Social Security Number. 
• Sex – Coded value for sex.  Hold your mouse over the value to view text description.  
• Race – Race indicated in the first race field of the Patient Set or record.  Hold your mouse 

over the value to view text description. 
• DOLC – Date of last contact. 
• VS – Vital status.  
• MRN – Medical record number. 
• Acc – Accession number. 
• Address – The patient’s current address. 

Data Search 
The Data Search can be accessed from the View menu.  Use the Data Search if you are: 

• looking for a set of records or Patient Sets that are similar in some way 

• and/or you want to create an extract of data fields 

• and/or you want to create QC Tasks or Resolve Patient Set Errors tasks for a set of data. 

There are several system permissions that control access to the data search.  Typically, coders 
should be given access to Patient Set and Record data searches, but system permissions related to 
exports and SQL searches should be assigned to a limited number of staff.  The system 
permissions related to data searches are described below. 
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• data_search_export – Create export files from listings created in the Data Search.  This 
permission is required to extract data from Patient Set, Record, or SQL searches. 

• data_search_filter_manager – Modify, delete, and assign saved searches (or filters) in the 
Data Search.  This gives the user access to all saved searches that they have the ability to 
execute. 

• data_search_run_pat – Execute Patient Set Data Searches. A user with this permission can 
run Patient Set searches that are available to their account. They cannot create Patient Set 
searches unless they also have the data_search_write_pat permission.  

• data_search_run_rec – Execute Record Data Searches. A user with this permission can run 
Record searches that are available to their account. They cannot create Record searches 
unless they also have the data_search_write_rec permission.  

• data_search_run_sql – Execute SQL Data Searches.  A user with this permission can run 
SQL searches made available to their account.  They cannot create SQL unless they also 
have the data_search_write_sql permission.   They cannot gain access to a saved search 
unless someone assigns it to their account; or they have the data_search_filter_manager 
permission. 

• data_search_write_pat – Create and execute Patient Set Data Searches. This permission 
allows the user to write data searches, and execute data searches assigned to their 
account, data searches assigned to their role, and data searches available to all users. 

• data_search_write_rec – Create and execute Record Data Searches. This permission allows 
the user to write data searches, and execute data searches assigned to their account, data 
searches assigned to their role, and data searches available to all users. 

• data_search_write_sql – Create SQL Data Searches. Execute SQL Data Searches assigned 
to the user's account, the user's role, or assigned to all users. A user with this permission 
can open another user's SQL data search, but cannot over-write it (the permission 
data_search_filter_manager is required to modify someone else's data search). This 
permission provides access to all data (patient data, staff productivity, etc) and should be 
restricted to registry managers, QC managers, and staff who write SQL for managers. 

Search Type 

In the Data Search, you must set the Search Type first because it will determine the type of fields 
that are available in other search filters (as shown below).  You can search for Patient Sets or 
records separately; or you can use SQL to run a query against any table in the database. 
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Patient Set Search 

  

Record Search SQL Data Search 

 

  
The Patient Set and Record 
searches have nearly 
identical filter sets.  For 
most registries, there is one 
additional filter for Record 
searches – the Import ID 
filter.  For some registries, 
there is a Region filter. 
 
SQL searches have just one 
filter.  You can paste SQL 
into the SQL filter and 
review the results in the 
system. 

 
 

Distinct Results 

  Distinct Results – if yes, each row in the 
results will be unique. If set to No, results may 
include duplicate rows.   

Examples: 

-- You search for CTCs dx’d between 1973-2008 

-- And you set your display fields to “Patient Set 
ID” and “Name” 

-- The criteria include a CTC-level field, but 
display fields are all at the patient level. 

If Distinct Results = No, you will get duplicates 
for patients who have 2 or more diagnoses in 
1973-2008.   “PAT-12345678, John Doe” could 
be listed twice. 

 

Recommendation:  Set Distinct Results to yes.  Only set it to no if the query is very slow and 
you either know that your search cannot include duplicate results; or you do not mind having 
duplicates in your results. 
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Distinct Results 

 

Distinct Results will prevent you from having duplicates in your results.   It comes into play when 
the search criteria fields are at a more detailed level than the display fields.    It is strongly 
recommended that you set it to Yes, but setting it to No will speed up some complicated searches.   

Before setting it to No, be sure that you understand that you may have duplicate rows in your 
results.  Review the example shown above.  The criteria include a CTC-level field, year of 
diagnosis, but the display fields are all at the patient level.  As an example, John Doe and the 
Patient Set ID will be listed twice if he had a prostate and a lung cancer diagnosis during those 
years.   If you do want a separate result for each cancer then you should include cancer fields in 
the result fields (you could include tumor record number, sequence number, or site).   If you only 
want patient name and ID, set distinct to yes so that you only get one result per patient. 
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Criteria 

The criteria determine which Patient Sets or records are returned in the results.  You can create a 
fairly complex multi-line statement.  The lines are joined with conjunctions:  “not”, “and”, “and 
not”, “or”, “or not”; and you can enter parentheses when the Boolean logic requires it.  When you 
are finished defining your criteria, click Apply (or Ctrl + Enter) to run your search. 

Your search will return a result set based on the full criteria statement “and-ed” with all other 
filters.  For example, the result set for a Patient Set Search is determined as follows. 

Patient Set Results = Criteria Statement + Worklist Task Filter + ID Filter + Special Study Filter.   

Only use a filter to reduce a list.  A filter should be cleared if you want all items regardless of that 
filter’s values.   For example, do not select anything in the Worklist Task Type filter if you want all 
data regardless of whether it is in the worklist. 
 
 

 
 
The statement above will return Patient Sets that meet these criteria: 

• Not deleted 
• Date of Last Contact prior to 2009 
• Vital Status = Alive 
• And have at least one CTC that meets these criteria: 

o CTC is not deleted 
o Age at DX <= 19 
o SEER Reportable 
o Not cervix in situ 
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Using Auto-complete to Search for a Field 

An auto-complete search is used to find fields for the Field Criteria, Display Fields, and Order By 
features.  There are several fields that are stored in different types of data.  For example, last 
name is a field in Patient Set Informants, Patient Set Aliases, and the Patient Set itself.   Be careful 
to verify the data entity when you select a field. 

 

 
 
Enter a question mark to view the lookup values for a field. 
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Worklist Task Type 

In a record search, the Worklist Task Type filter allows you to search for records that are the focus 
of a worklist task.  You would not use the Data Search just to find records in the worklist.   You 
should use the worklist for that.   But you can use the Data Search to find records that meet other 
criteria and are in the worklist; or records that meet some criteria but are not in the worklist. 

This filter only considers the record that is the focus of the task.    For example, records listed as 
possible matches in Match tasks are not considered by this filter.  Records can be the focus of 
these tasks: 

• Match or Match Review 
• Pathology Screening or Screening  
• QC Record 
• Resolve Record Errors 
• Review Path Matching 
• Review Pull List 
• Review Special Studies 

 

You can search for “Is Missing” to find records that are not in the workflow.  You can search for “Is 
Not Missing” to search for records that are in any type of task.   

In a Patient Set search, the Worklist Task Type filter allows you search for Patient Sets that meet 
other search criteria and are in the worklist; or you can use this filter to exclude Patient Sets that 
are in the worklist. Patient Sets can be the focus of these tasks: 
 

• Consolidate 
• QC Patient Set 
• Resolve Duplicate Patient Set 
• Resolve Patient Set Errors 
• Review Data 

 
One common use of this filter in a Patient Set Search would be to search for Patient Sets that are 
failing an edit but are not in Resolve Patient Set Errors tasks.  (To search for Records or Patient 
Sets with a particular edit, set the Criteria to Edit Rule ID is <Edit ID>.) 

ID Filter 
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Use the ID Filter to search for Patient Sets or records by ID.   

• You can search for a single ID or paste a long list of IDs into the filter.  Each ID in a list 
must be separated by a blank or a comma. 

• The PAT- and REC- prefixes are optional.    
• Use “Is Not” to exclude certain Patient Sets or records from your search. 
• The results of the ID filter will be “and-ed” with the Criteria statement and the other filters. 

Special Study Filter 

Use the Special Study Filter to search for Patient Sets or records by study.   

• You can search for records or Patient Sets that are in a certain special study. 
• Or use “is not” to search for data that are not in a specific study. 
• Or search for data not in any study (use the Missing option).    

Import ID Filter 

Use the Import filter to search for records loaded in a specific import.  This filter is only available 
when Search Type is set to Records.  All imports are listed when you first click Import.  Use the 
search box at the bottom to find the Import ID.  The search text will be matched against Import 
ID, File Type, Username, and Facility ID.   

Complete the filter statement of “Import <is or is not> Import ID”.   To do this, you may enter an 
Import ID into the text box at the top; or check the box next to the import in the search list.  You 
may enter a set of IDs or even a range of IDs.  The IMP- prefix is optional. 
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Display Fields 

The Display Fields option defines the columns shown in the results table.  The default list of Display 
Fields is defined in the registry configuration; some registries only include patient level 
demographic fields in the default set while other registries include tumor-level fields.  To change 
your registry’s default display fields, contact IMS. 

To change the order of the fields, first select the Display Fields header, then grab a field with your 
cursor and move it up or down in the list.  A field is highlighted when it is selected, as shown 
below. 

 

 

Order By 

Use Order By to define the sort order of the results.  The default sort order is Patient Set or Record 
ID in ascending order.  You may specify multiple sort fields and you may specify ascending or 
descending for each.  Your results can only be sorted by fields that are listed as Display Fields.   
Use the auto-complete search box to find a field.  Click Ascending to toggle to Descending and 
vice versa.  Once a list is created, you may grab a field to move it up or down in the list. 

 

 

Convert to SQL Search  

To view the SQL code used for the search, click Actions > Convert to SQL Search.  The SQL is 
shown in the SQL tab.  You may begin your search in the Patient Set or Record Search view as a 
starting point, then convert to SQL to continue building your query. 
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Reviewing Results in the Data Search 
The data returned by your search will be displayed in the Results section of the screen.   
 

 
 

• The total number of results is shown in the Results tab in the lower half of the screen.  Click 
maximize to enlarge the viewing area. 

• 40 results are displayed per page.  There are page controls on the right side of the screen. 
• You may open a Record or Patient Set by clicking its ID. 
• Click the double arrow next to the word Criteria to hide the filter panel and expand the 

width of the results table.   Click it again to re-open the filter panel. 

Data Search Action Menu 
The Actions associated with the Data Search are: 

• Save Filter – If you frequently search for the same type of data, you do not need to 
redefine your search each time.  Saved searches are available in the drop-down list and 
Filters tab.  All users can see saved searches that they created and searches made available 
to them by another user.  Users with the data_search_filter_manager permission can access 
all saved searches.  A data search manager can create searches for others to use and 
provide technical support to users who have saved searches.  

• Delete Filter – Use this to remove the current saved search.   
• Create QC Tasks – A QC Task can be created for each record or Patient Set in the results.  

You will be prompted to provide instructions for the coders who complete the tasks.   You 
will be able to assign the tasks to another user, assign them to your own account, or leave 
the user field blank to create unassigned tasks.   If appropriate, you can set a worklist flag 
and/or assign a subject to the QC project.  You may also set the parameters of the tasks in 
the Parameters tab. 
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• Send Into Workflow – (requires send_into_workflow permission)  This option sends 
records to an earlier point in the workflow.  If you are unsure of the appropriate entry point 
or possible ramifications of sending these records into the workflow, please contact 
SEER*DMS Technical Support. It is recommended that you test the process on the 
SEER*DMS test server before sending a large number of records into the production 
workflow. 

• Export – Use the Export option to create a text file containing all rows and columns in the 
results.  This option is only available to users with the data_search_export permission.  The 
export file will be a Comma Separated Values (CSV) text file, a common file format that can 
be opened in Excel and other spreadsheet applications. 

• Export to Report Output Task – The report will be generated as a Report Output Task.  
Click the TSK-ID provided in the Export Tab to view the output.  The format will be a CSV 
text file and will be identical to the export file created using the Export option. 

• Help – Select Help to review the Data Search tutorial.  The tutorial is also available in PDF 
format online at seer.cancer.gov/seerdms/manual. 

SQL Data Searches 
The data_search_write_sql permission is required to create SQL Data Searches.   This permission 
should be restricted to advanced users who have experience writing SQL queries.   
 

 

The data_search_run_sql permission allows users to execute SQL Data Searches made available to 
their account.  They may have written the SQL data search or it may have been written by 
someone else and made available to their account, all users, or users with their role.  Select SQL 
Searches from the <Any Search Type> drop down menu on the Filters tab, or use the drop down 
menu below the Action Menu.  The screen shot below shows 3 SQL searches listed on the Data 
Search Filters tab.  All were created by the same user.  The first can only be executed by users 
with the Director role who have the data_search_run_sql permission.  The second can only be 
executed by the user who created the search (and by any managers who have the 
data_search_write_sql permission).  The third search can be executed by all users who have the 
data_search_run_sql permission.   
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Direct Editing of Records and Patient Sets  
Requires system permission:  pat_edit, pat_edit_demographics, pat_edit_overrides, 
pat_edit_cs_overrides, pat_edit_county, pat_read_only, rec_edit, or rec_read_only 

SEER*DMS enables users to edit records or Patient Sets accessed via the Patient Lookup or Data 
Search.  Your read/write access to data is not restricted to workflow tasks.  This type of editing is 
called “Ad Hoc Editing.”   This creates the possibility that two users may open the same record or 
Patient Set simultaneously.  It is also possible for you to open a record or Patient Set that is 
currently being processed in an automatic task, or that is involved in a manual task.  Prior to 
editing data that you access via the Patient Lookup or Data Search, please review the information 
below and follow the appropriate steps to avoid having your or another user’s changes overwritten.  

If you attempt to modify data that has been modified by another user or process: 

Two users may open and edit the same record or Patient Set.  If this happens simultaneously, 
the first person to attempt to save the data will be able to successfully save their changes.  If 
the other person attempts to save changes, SEER*DMS will display an error message indicating 
that the record or Patient Set has been modified since the data were opened in the editor. 
SEER*DMS will post an error message with instructions: 

• Error: These data have been modified by another person or process; your changes cannot 
be saved. Print the data if you need a listing of your current values. Reload the data by 
selecting Undo Changes from the menu.  You should review the revision history in the audit 
log prior to re-entering and saving your edits.  

• The same message will be displayed if the data were modified by a process after you 
opened the editor but before you saved the data.  In either situation, you should review the 
audit log to determine which user or process modified the data and what changes were 
made.   You may continue editing, if appropriate. 

If you attempt to modify data involved in a workflow task: 

You may modify a Patient Set or record that is in a workflow task.  For some tasks, there is no 
conflict and your work may complete the task.  For example, you open a Patient Set via the 
data search and that Patient Set is in a Resolve Patient Set Errors task.  No warning will be 
displayed in the editor because there is no potential conflict.  If you clear all edits and save the 
task, the worklist task will be completed and the Patient Set will exit the workflow.  However, 
there could be a conflict if you edit a record that is in a Consolidate task.  You should either 
open the task and make the appropriate changes to the Patient Set and/or record, or contact 
the person to whom the task is assigned.  

If there is a potential conflict with a task, an Alert will be posted in the record or Patient Set 
editor.  SEER*DMS will post a warning message and provide a link to review the task.  It is 
generally recommended that you access and edit data in the context of the pending task.  You 
should certainly review the task prior to making changes, to ensure that you and another staff 
member are not duplicating effort or editing the same data simultaneously. 
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